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Database: A database is a collection interrelated data from which some information can be extracted. The 
collection of the data must be logically coherent with some inherent meaning. 
 
Database Management: Earlier the organizations followed the fragmented approach to data processing 
by designing files to specially suit different application systems. Since the different departments in 
organizations have large amount of data to share this approach leads to some major disadvantages.  The 
evaluation of database management was accompanied and promoted by: 

1. Advances in computing: Hardware, OS and Networking. 
2. Drawbacks of the prevalent approach of Data Management. 

• Data Redundancy: Since the files and applications programs are written over a long 
period of time, data in the files is likely to be get repeated. This may also lead to 
inconsistency i.e. various copies of the same data may contain different information. 
Data redundancy could also occur due to duplication of data at different locations. 

• Data Isolation: Since data is scattered at various file, and files may be in different 
formats, it is difficult to write new application programs to retrieve the appropriate data. 

 
Introduction to DBMS: A DBMS is a general-purpose software system that enables users to define and 
manipulate databases. It provides an environment wherein data can be stored and retrieved from the 
databases easily and most efficiently. The main drawbacks of the DBMS that it cannot represent Many-to-
Many relationship. 
 
Relational Model:  

• Data organized in terms of rows and columns in a table known as relations. 
• The position of a row in a table is of no importance. 
• The intersection of a row and a column must give a single value and not a set of values. 
• Column names must be unique. 

 
Tables: A fundamental structure of Relational Database Management System. It stores data in records 
(rows) and fields (columns). 
 
 
Creating A Blank Database In Access: If you want to design your own database, you can create a blank 
database. Creating your own database gives you the flexibility to specify the tables to be included in the 
database. It thus offers you more flexibility and control over the design of a database. You can create a 
blank database by selecting it in the initial screen only. After creating the database structure, you can 
make tables in it, rename fields according to your requirements and enter data as well. You can also 
include new fields as well as delete unwanted fields from your database. You can delete the fields you 
don't require any longer by selecting the 'Delete' option from the 'Edit' menu. You can also specify a 
Primary key for your Tables. If you have not created a Primary Key for your Tables then Access will 
automatically ask you to create one when you close your database.  

 
Create a database using the Database Wizard 

1. When Microsoft Access first starts up, a dialog box is automatically displayed with options to 
create a new database or open an existing one. If this dialog box is displayed, click Database 
Wizard, and then click OK.  
If you have already opened a database or closed the dialog box that displays when Microsoft 
Access starts up, click New Database on the toolbar.  

2. On the Databases tab, double-click the icon for the kind of database you want to create. 
3. Specify a name and location for the database. 
4. Click Create to start defining your new data 
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Create a table by using the Table Wizard 
1. If you haven't already done so, switch to the Database window. You can press F11 to switch to 

the Database window from any other window. 
2. Click Tables under Objects, and then click New on the Database window toolbar. 
3. Double-click Table Wizard. 
4. Follow the directions in the Table Wizard dialog boxes.  

Note   If you want to modify or extend the resulting table, you can do so in Design view when you have 
finished using the Table Wizard. 
 
Create a table from scratch in Design view 

1. If you haven't already done so, switch to the Database window. You can press F11 to switch to 
the Database window from any other window. 

2. Click Tables under Objects, and then click New on the Database window toolbar. 
3. Double-click Design View. 
4. Define each of the fields in your table.  

How?  
5. Define a primary key field before saving your table.  

How?  
Note   You don't have to define a primary key, but it's usually a good idea. If you don't define a 
primary key, Microsoft Access asks if you want it to create one for you when you save the table.  

6. When you are ready to save your table, click Save on the toolbar, and then type a name for the 
table following Microsoft Access object-naming rules.  

Create a new table from existing data 
Microsoft Access provides two ways to create a table from existing data:  

• You can import or link data from another Microsoft Access database or data in a variety of file 
formats from other programs. 

• You can perform a make-table query to create a table based on data in a current table. For 
example, you can use make-table queries to archive old records, to make backup copies of your 
tables, to select a group of records to export to another database, or to use as a basis for reports 
that display data from a specific time.  

 
Primary Key: 
One or more fields whose value or values uniquely identify each record in a table. A primary key cannot 
allow Null values and must always and must always have a unique index. A primary key is used to relate 
a table to foreign keys in other tables. A 'Primary Key' ensures that each record in the database remains 
unique and that there exist no two similar records. The primary key of a table performs two duties. 

1. Because it is guaranteed to be unique on every record, it enforces entity integrity. 
2. It serves as an anchor referential integrity. 

  
Foreign Key: 
A foreign key is a copy of the primary key in the parent table that is inserted in the child table to create 
relationship between two. 
 
Should I import or link a table? 
You can link a table only in a Microsoft Access database, not a Microsoft Access project. 
 
Reasons to import data into a table 
If you know that you will use your data only in Microsoft Access, you should import it. Microsoft Access 
generally works faster with its own tables, and, if you need to, you can modify the imported table to meet 
your needs just like any other table that is created in Microsoft Access. 
 
How should I import a table? 

1. To import Tables, on the File Menu, point to Get External Data and then click to Import. 
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2. In the Import dialog box, in the Files of Types Box, Select ODBC Databases(). 
 
Reasons to link data from an external table 
If a program other than Microsoft Access is also updating the data that you want to use in your Access 
database, you should link it. Using this approach, the current methods of updating, managing, and sharing 
the data can remain in place, and you can use Microsoft Access to work with the data as well. For 
example, you can create queries, forms, and reports that use the external data, combine external data with 
the data in Microsoft Access tables, and even view and edit the external data while others are using it in 
the original program. 
You can also link tables from other Microsoft Access databases. For example, you might want to use a 
table from another Microsoft Access database that is shared on a network. This is particularly useful if 
you want to store all of your tables in one database on a network server, while keeping forms, reports, and 
other objects in a separate database that is copied among users of the shared database. You can easily split 
an existing database into two databases by using the Database Splitter subcommand on the Database 
Utilities command on the Tools menu. 
 
Add a field to a table in Design view 

1. Open the table in Design view. 
2. To insert the field within the table, click in the row below where you want to add the field, and 

then click Insert Rows on the toolbar.  
To add the field to the end of the table, click in the first blank row.  

3. Click in the Field Name column and type the name for the field, following Microsoft Access 
object-naming rules. 

4. In the Data Type column, keep the default (Text); or click in the Data Type column, click the 
arrow, and select the data type you want..  

5. In the Description column, type a description of the information this field will contain. This 
description is displayed on the status bar when adding data to the field and is included in the 
Object Definition of the table. The description is optional. 

6. If you want, set field properties for the field in the bottom part of the window.  
 
 
Field data types available in Microsoft Access 
The following table summarizes all the field data types available in Microsoft Access, their uses, and their 
storage sizes. 

Data type Use for Size 

Text Text or combinations of text and numbers, 
such as addresses. Also numbers that do 
not require calculations, such as phone 
numbers, part numbers, or postal codes.. 

Up to 255 characters. Microsoft Access 
only stores the characters entered in a 
field; it does not store space characters 
for unused positions in a Text field. To 
control the maximum number of 
characters that can be entered, set the 
FieldSize property. 

Memo Lengthy text and numbers, such as notes 
or descriptions.. 

Up to 64,000 characters. 

Number Numeric data to be used for mathematical 
calculations, except calculations involving 
money (use Currency type). Set the 
FieldSize property to define the specific 
Number type. 

1, 2, 4, or 8 bytes. 16 bytes for 
Replication ID (GUID) only. 
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Date/Time Dates and times. 8 bytes. 

Currency Currency values. Use the Currency data 
type to prevent rounding off during 
calculations. Accurate to 15 digits to the 
left of the decimal point and 4 digits to the 
right. 

8 bytes. 

AutoNumber Unique sequential (incrementing by 1) or 
random numbers automatically inserted 
when a record is added. 

4 bytes. 16 bytes for Replication ID 
(GUID) only. 

Yes/No Fields that will contain only one of two 
values, such as Yes/No, True/False, 
On/Off. 

1 bit. 

OLE Object Objects (such as Microsoft Word 
documents, Microsoft Excel spreadsheets, 
pictures, sounds, or other binary data), 
created in other programs using the OLE 
protocol, that can be linked to or 
embedded in a Microsoft Access table. 
You must use a bound object frame in a 
form or report to display the OLE object. 

Up to 1 gigabyte (limited by disk 
space). 

Hyperlink Field that will store hyperlinks. A 
hyperlink can be a UNC path or a URL. 

Up to 64,000 characters. 

Lookup Wizard Creates a field that allows you to choose a 
value from another table or from a list of 
values using a combo box. Choosing this 
option in the data type list starts a wizard 
to define this for you. 

The same size as the primary key field 
that is also the Lookup field; typically 4 
bytes. 

 
Format Property 
                   
You can use the Format property to customize the way numbers, dates, times, and text are displayed and 
printed. For example, if you've created a Price text box, you can set its Format property to Currency and 
its Decimal Places property to 2 or Auto. If you enter 4321.678 in the control, the number would be 
displayed as $4,321.68. 
You can use one of the predefined formats or you can create a custom format by using formatting 
symbols. 

Validation Rule: A rule that sets limits or conditions on what can be entered in one or more fields. A 
validation rule for the field is checked when you move to different record. 

Validation Text: Access displays a message specified in validation text property whenever the rule 
violates. The maximum length for the Validation Text property setting is 255 characters. 

Default Value: The Default Value property specifies text or an expression that's automatically entered in 
a control or field when a new record is created. For example, if you set the Default Value property for a 
text box control to =Now(), the control displays the current date and time. The maximum length for a 
Default Value property setting is 255 characters. 
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Required: You can use the Required property to specify whether a value is required in a field. If this 
property is set to Yes, when you enter data in a record, you must enter a value in the field, and the value 
cannot be Null. 

Allow Zero Length You can use the Allow Zero Length property to specify whether a zero-length string 
(" ") is a valid entry in a table field. 

Input Mask: You can use the Input Mask property to make data entry easier and to control the values 
users can enter in a text box control. For example, you could create an input mask for a Phone Number 
field that shows you exactly how to enter a new number: (___) ___-____. It is often easier to use the Input 
Mask Wizard to set the property for you. 

Retrieving Record Using Queries In Access: A Database is a huge collection of data. Think of a 
situation when you want to access a particular piece of data. Let us consider a Database of students. You 
want to access the records of only those students whose names start with 's'. Query is the feature that 
handles problem of this kind. A Query can be used to find out specific information from your database. 
You can construct a Query and specify the criteria as names beginning with 's'.Access offers different 
kinds of Queries to work with. For example, there is the 'Select Query' that lets you retrieve some specific 
data based on your requirements. The 'Select Query' will enable you to set some criteria on the basis of 
which the data is to be retrieved. Selecting the Query option in the database window can make queries. 
You can specify the criteria and then run the query by clicking on the 'Run Query' button on the toolbar. 
The result sent back by the Query can be sorted according to your requirements. The result can be 
arranged in the ascending or the descending order. 
 
Queries: There are many types of queries in Access which are briefly discussed below: 

1. Select Query: A select query is the most common type of query. It retrieves data from one 
or more tables and displays the results in a datasheet where you can update the records 
(with some restrictions). You can also use a select query to group records and calculate 
sums, counts, averages, and other types of totals. 

2. Parameter Query: A parameter query is a query that when run displays its own dialog box 
prompting you for information, such as criteria for retrieving records or a value you want 
to insert in a field. You can design the query to prompt you for more than one piece of 
information 

3. Crosstab Queries: A crosstab query displays summarized values (sums, counts, and 
averages) from one field in a table and groups them by one set of facts listed down the 
left side of the datasheet and another set of facts listed across the top of the datasheet. 

4. Action Queries: 
a. Delete Query: Deletes a group of records from one or more tables. For example, you 

could use a delete query to remove products that are discontinued or for which there are 
no orders. With delete queries, you always delete entire records, not just selected fields 
within records. 

b. Append Query: Adds a group of records from one or more tables to the end of one or 
more tables. For example, suppose that you acquire some new customers and a database 
containing a table of information on those customers. To avoid typing all this information 
in, you'd like to append it to your Customers table. 

c. Update Query: Makes global changes to a group of records in one or more tables. For 
example, you can raise prices by 10 percent for all dairy products, or you can raise 
salaries by 5 percent for the people within a certain job category. With an update query, 
you can change data in existing tables. 

d. Make Table Query: Creates a new table from all or part of the data in one or more 
tables. 

5. SQL Queries 
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a. Union Query: This type of query combines fields (columns) from one or more 
tables or queries into one field or column in the query's results. For example, if 
you have six vendors that send new inventory lists each month, you can combine 
these lists into one result set using a union query, and then create a make-table 
query based on the union query to make a new table. 

b. Pass Through Query: This type of query sends commands directly to ODBC 
databases, such as Microsoft FoxPro, using commands that are accepted by the 
server. For example, you can use a pass-through query to retrieve records or 
change data. 

c. Data definition Query: This type of query creates, deletes, alters tables, or creates 
indexes in a database. 

d. Sub Query: This type of query consists of an SQL SELECT statement inside 
another select query or action query. You can enter these statements in the Field 
row of the query design grid to define a new field, or in the Criteria row to define 
criteria for a field. 

 
 
Creating Forms In Access: Forms are used in MS Access for the visual presentation of data. They can 
display one record at a time so that you can easily edit your data as well as enter new data. Forms provide 
a more structured view of your data. Access offers you a form wizard to assist you in designing forms. 
The form wizard provides several types of layouts, which determine the arrangement of information on 
the form. At the same time, you can also specify a style for your Forms. Styles enhance the appearance of 
your Forms. After the form is created, it displays the field names that you have selected as well as the data 
for the first record. It also displays some navigation buttons at the bottom of the form so as to enable you 
to move to different records. Here you can add, delete and edit your data. Moreover, you can also sort 
your data in the ascending or the descending order. For sorting data in ascending or descending order, 
select 'Sort' option from the 'Records' menu and then select ascending or descending option. 
 

Create a form by using AutoForm 

AutoForm creates a form that displays all fields and records in the underlying table or query. If the record 
source you select has related tables or queries, the form will also include all the fields and records from 
those record sources.  

1. In the Database window, click Forms under Objects. 
2. Click the New button on the Database window toolbar. 
3. In the New Form dialog box, click one of the following wizards:  

o AutoForm: Columnar:  Each field appears on a separate line with a label to its left. 
o AutoForm: Tabular :  The fields in each record appear on one line, with the labels 

displayed once at the top of the form. 
o AutoForm: Datasheet :  The fields in each record appear in row-and-column format, with 

one record in each row and one field in each column. The field names appear at the top of 
each column.  

4. Click the table or query that contains the data you want to base your form on. 
5. Click OK.  

Microsoft Access applies the last autoformat you used to the form. If you haven't created a form with a 
wizard before or haven't used the AutoFormat command on the Format menu, it uses the Standard 
autoformat. 
 
Create a form with a wizard 
 

1. In the Database window, click Forms under Objects. 
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2. Click the New button on the Database window toolbar. 
3. In the New Form dialog box, click the wizard that you want to use. A description of the wizard 

appears in the left side of the dialog box. 
4. Click the name of the table or other record source that includes the data you want to base your 

form on.  
5. Click OK.  

 
Create a report using Auto Report 
AutoReport creates a report that displays all fields and records in the underlying table or query.  

1. In the Database window, click Reports under Objects. 
2. Click the New button on the Database window toolbar. 
3. In the New Report dialog box, click one of the following wizards:  

o AutoReport: Columnar. Each field appears on a separate line with a label to its left. 
o AutoReport: Tabular. The fields in each record appear on one line, and the labels print 

once at the top of each page.  
4. Click the table or query that contains the data you want to base your report on. 
5. Click OK.  

Create a blank report and select a record source 
1. In the Database window, click Reports under Objects. 
2. Click the New button on the Database window toolbar. 
3. In the New Report dialog box, click Design View. 
4. Click the name of the table or query that contains the data you want to base your report 

on. (If you want an unbound report, don't select anything from this list.)  
5. Click OK.   
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